Annotating the price charts

- Annotating price charts -

and how to
easily record
copious notes
using
BullCharts software

[ 4 Robert Brain
.
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Toolbox

Price charts summarise the underlying

} opinions and emotions of the market participants
Every chart tells a story.
It pays to understand the stories in the price charts.
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Introduction

When looking for stocks to buy:
study the price chart and
record the analysis and observations,
and then revisit the notes at a later time.

* What sort of observations
are we talking about?

+ What are the options
for recording them?

Introduction

When | study the charts...

| look at price action from a few different “angles”:

= Daily chart looking for trend lines, support or
resistance levels and chart patterns

= “Weinstein” weekly chart with 30 week MA
* Momentum indicator (weekly)

* Twiggs Money Flow

= GMMA (daily on weekly candles)

= Candle patterns

* Volume.
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Annotating the price charts

Introduction

Imagine the complex chart details

If all of these details went onto one price chart,
imagine how complicated it might look.

Trend lines, support, resistance and chart patterns (daily chart)

-.:#‘

“Weinstein™ weekly chart with MA
Momentum indicator (weekly)
Twiggs Money Flow

GMMA (daily on weekly candles)
Candle patterns

Volume.

Introduction

In this session...

* Consider the multitude of different
technical analysis studies in BullCharts;

= Consider the different options for
recording the details.

Introduction

Interactive...
* Please ask questions.

« Let's discuss details.

= Any price charts prepared
with BullCharts software.

i.--.i www.bullcharts.com.au
BullCharts

Every chart tells a story.
It pays to understand the stories in the charts.
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Annotating the price charts

Introduction

Important Notice — No Advice!
« This presentation does not include any advice.

o

« For proper advice, your personal financial
situation needs to be considered.

* This presentation is pure education,
only for your general awareness.

= There are no recommendations to take any
action, or to invest any money in any way.

= Always consult a properly licensed advisor
before making investment decisions.

b ]

& Coppeg K078 Poowe I rain — Brsiy's Sher Mawes Tookbnr — g ST T

Introduction

Important Notice
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Making notes and annotating the charts

Here's what | like to do

On a weekly basis (for index and stocks)
view the templates and make notes etc.

Can be easy in BullCharts
using BullCharts Templates
which are saved to my Template Toolbar.

A Ao WD AR \ALE RS WS AT LALR: VARG
| W1 Wican W2 W3 W4 W5 W6 W7 W8 W9 \

Wi, Wican = Daily line {and candles) for: Trends, Support, Resistance, Patterns,
W2 = Weinstein — 30 week MA (on weekly chart).

W3 = Momentum (weekly) WE = Candle patterns.
W = Twiggs Money Flow (weekly) W7 = OBV (daily)
W5 = GMMA (daily GMMA on weekly candies), W8 = Volume [daily)
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Annotating the price charts

Making notes and annotating the charts

My template “W1”

=

Note:
IntelfiCharts is currently enabled.
So BullCharts will remember my line studies, etc

= Datly line chart
* Trand lines (dotted)
* Horizontal levels of support of resistance
» Any chart patterns? — Congestion range

A1

&

Making notes and annotating the charts

My template “W1candles”

ol o waiee

8

* Trend lines (dotted, applied using W1 tempiate)
= Horizontal levels of support or resistance
+ SMA(50 days), and SMA(200 days)

1 * Any chart patterns? — Congestion range.

g

Making notes and annotating the charts

My template “W2”

{5 Sl m i mrem

et -
o:h D T Some annotations on this chart are not wanted for
;.l___ . this "Weinstein” study. | wish | could easily hide them.
f . 3

i ‘ ~ —
oarhe Wiy

- -
“Weinstein” chart:
d] l = Weekly candie chart

= SMA (30 week) and EMA, (30 week)
= Stage Analysis ribbon (across the bottom)

Unwanted “carry-over” from earlier study (in InteliCharts)-
T ted)

s of support or resistance

terns? — Congestion range.
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Annotating the price charts

Making notes and annotating the charts

Templates are good, but...

* The Templates provide a quick way to simply
eye-ball the basic chart and do basic analysis.

* But as | add more details, IntelliCharts captures
all the details and the charts get cluttered and
unworkable.

* Instead of using IntelliCharts, | “Save..."” the
charts as in the following slides.

Making notes and annotating the charts

Demonstration

We could toggle across to BullCharts
and view these templates in action...

OR
simply move on:
Turn IntelliCharts OFF and “Save...” chart files.
Now view the resulting
saved chart files...

Making notes and annotating the charts

Daily candles — Trends, etc.

T =

[Peaks and 1.
Troughs

Support |
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Annotating the price charts

Making notes and annotating the charts

Weinstein
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Making notes and annotating the charts

Momentum
Peaks and
Mocrara, indic Tmths
sty L Eaan e looking for
= divergence

Making notes and annotating the charts

Twiggs Money Flow
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Peaks and
Troughs
looking for
divergence
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Annotating the price charts

Making notes and annotating the charts
GMMA
| Interpreting g

| the GMMA
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Making notes and annotating the charts

Candle patterns

Making notes and annotating the charts

Volume
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Annotating the price charts

Making notes and annotating the charts

Intraday — 10 minute chart

Making notes and annotating the charts

BTW — Why?
Why do | do all this on the index, and for possible
stock purchases?

1. It gives me several “views” of
what is going on;

2. It enables me to draw a conclusion about the
bullishness or bearishness of the security;

3. Some of my discretionary trading rules use
some of these “observations”.

Making notes and annotating the charts

What BullCharts tools?

What BullCharts “Line Studies” tools are available to us?

+ Text Box and its features

(colour and size of text, Border, Fill, “Anchor to Date”)
* Lines (Interval, Ray, Vertical, Cross-hair, Parallel, Band, etc.)
+ Rectangle, Ellipse, Parabola.

+ Fibonacci tools. Lots of toals

+ Range Info and Compound Candle. applied to the

* Regression tools p”gc;cr:j;f"

* Measure tools (Time, Value, Percent, Ruler)

= Alerts

* lcons
Rls-o-E-E--H-d-F-ll-W-5-b A
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Annotating the price charts

Making notes and annotating the charts

Let's think about...

1. Analysing the charts, and

2. Making notes and “annotations”
and capturing them for future reference.

3. What are the options?

Making notes and annotating the charts

“annotations”?
We use the word annotations to refer to:
* Text (small, large, short strings, long, boxes);

* Lines — trend lines, channel lines,
lines with arrows;

*Vertical lines, Cross hairs;
* Fib retracement/extension;
* Gann studies;

= Symbols/icons;

* (and chart indicators).

oy 32 Rt B B — B

Making notes and annotating the charts

Recording notes with BullCharts
In BullCharts:

1. More than one way to record annotations:
(a) IntelliCharts (with two options);
(b) Menu option: “Save File as...”
(c) Use the Chart Memo feature
2. Can have multiple charts open for each stock

3. Can have different analyses and different
annotations for different time periods
(ie. daily, weekly, monthly, etc.)
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Annotating the price charts

Making notes and annotating the charts

BC IntelliCharts is easy

1. This feature is automatically enabled by
default; but can be turned off.

2. Will remember the annotations for your chart
(stored in a small separate text file).

This is easy:
3. If your analysis is simple, and/or

4. If the same analysis and comments applies
across multiple time periods.

Otherwise, we need “plan B"...

Making notes and annotating the charts

BC IntelliCharts (advanced?)

In IntelliCharts, we can enable the second option
“Save different ... for each time period”.
(ie. separate for: daily, weekly, monthly, etc.)

Menu ophon Fle Edt View [nsert Format Tooks Alerts Acions Window Help
Tools > € BuliCharts Preferences

Preferences >

IntelliCharts

(tab)

Making notes and annotating the charts

Saving the analysis — “Plan B”
Another way to do all this:
1. Turn IntelliCharts off;
2. Do analysis and annotate the chart;
3. Menu option: File > Save

For the displayed security, this will save:

(a) the annotations, and (b) the fayout and (c) the time
period and (d) the indicators and (e) the various chart
panes into a special BullCharts file (for one price chart).

The next time you open this file, the latest price data will
be displayed and the saved annotations will be added to
the price chart. L=

B T T
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Annotating the price charts

Making notes and annotating the charts

“Save...” the file MEEER

e e et E

* This will create and save a ] tiew

- chrky

small text file to your computer. o

» Just like in MS-Word and Excel, W o]
you will need to specify a file name, i ZRN )
and specify a folder in which to save it.

* My suggestion is to create a folder here:
C:\Program Files (x86)\BullSystems\BullCharts
| created a sub-folder here called:

My Files

* To retrieve file, simply use menu: File > Open

=)
e e

Making notes and annotating the charts

“‘Save...” the file (cont )

After a while, there
might be many files that

you use, so use the

menu option:

Files > Recent Files

to see a list. R :
To increase the o T =
capacity/length of this list,
use menu option: Tools >

Preferences >
General (tab)

Making notes and annotating the charts

Another option in BullCharts

In BullCharts there is one more way to store plam
text with a stock:

Use the Chart Memo |
feature (a window pane|«
that opens below the |,

price pane). \ ol
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Annotating the price charts

Making notes and annotating the charts

BTW — Layer Manager

If a chart is rather detailed and complex, and

you have trouble identifying the various elements
and making changes to “properties” etc.,

there are two ways to assist:

1. Use Layer Manager, or

2. Make use of the elements in the
Pane Title bar.

P EaETE]
{u} Copyright, October 2030, R 6 Brain

Making notes and annotating the charts

Layer Manager
1. Use menu option: View > Panels

2. Or open the Security Manager
or Scan Manager and click on
tab.

(c) Copyright 2020, Robert B Brain
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Annotating the price charts

{ Making notes and annotating the charts

Summary of BullCharts options

1. IntelliCharts — simple to use with same
annotations in all time periods

2. IntelliCharts — or enable the option:
“Save different ... time periods”

3. Turn IntelliCharts off and “Save File”
4. Chart Memo feature
5. Layer Manager can help.

Summary & Wrap up

Making analysis notes...

Depending on the analysis,
and the charting tools used,
it can be easy to record
the analysis details
and readily view again later.

¥ .

Every chart tells a story.
It pays to understand the stories in the charts.
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Summary & Wrap up

Q&A?

Any
questions?

(c) Copyright 2020, Robert B Brain




Annotating the price charts

Summary & Wrap up

Don't forget my Toolbox
* Brainy's Share Market Toolbox '
*  www.robertbrain.com
Loads of eBook (PDF) Articles <
* Info: share market, charting, BuIIChaﬂg
Weekly Market Updates and Watch List
monthly e-Newsletters
* Good software — BullCharts
www.robertbrain.com/bullcharts/
* My contact details:
web site above, or phone: 0438 355 910

SRR —

Summary & Wrap up

THE END

See free stuff here:
www.robertbrain.com/free

Thank you.

www.robertbrain.com

or phone: 0438 355 910
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